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1.  INTRODUCTION

The BL4S100 series of high-performance, C-programmable single-board

computers offers built-in RS232, digital I/O and analog inputs combined

with the Ethernet and Zigbee network connectivity in a compact form fac-

tor. The BL4S100 single-board computers are ideal for both discrete manu-

facturing and process-control applications.

A Rabbit® 4000 microprocessor provides fast data processing.

1.1  BL4S100 Description

Throughout this manual, the term BL4S100 refers to the complete series of BL4S100 single-

board computers unless other production models are referred to specifically.

The BL4S100 is an advanced single-board computer that incorporates the powerful Rabbit 

4000 microprocessor, serial flash memory, static RAM, digital inputs, digital outputs, A/D 

converter inputs, RS-232 serial ports, and Ethernet and ZigBee network connectivity.

1.2  BL4S100 Features

� Rabbit 4000 microprocessor operating at 40.00 MHz.

� Screw-terminal connectors

� 512KB SRAM (battery-backed), 512KB/1MB fast SRAM, and 1MB/2MB flash memory 

options.

� 20 digital I/O: 12 protected digital inputs, and 8 sinking digital outputs.

� Advanced input capabilities including event counting, event capture, and quadrature 

decoders that may be set up on all the digital input pins.

� Independent PWM and PPM capability on all the digital output pins.

� Eight 11-bit A/D converter inputs (plus one bit for sign).

� Ethernet and ZigBee network connectivity.

� Three serial ports:

 Two 3-wire RS-232 serial ports or one 5-wire RS-232 serial port:

 One serial port dedicated to programming/debugging.

� Battery-backed real-time clock.
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� Watchdog supervisor.

Four BL4S100 models are available. Their standard features are summarized in Table 1.

BL4S100 single-board computers are programmed over a standard PC USB port through a 

programming cable supplied with the Tool Kit.

NOTE:  BL4S100 Series single-board computers cannot be programmed via the RabbitLink.

Appendix A provides detailed specifications.

Table 1.  BL4S100 Models

Feature BL4S100 BL4S110 BL4S150 BL4S160

Microprocessor Rabbit 4000 running at 40.00 MHz

Program Execution SRAM 512KB 1MB

Data SRAM 512KB

Serial Flash Memory 

(program)
1MB 2MB

A/D Converter 12 bits

Ethernet Interface 10Base-T

ZigBee Interface
ZigBee PRO

(802.15.4)
—

ZigBee PRO

(802.15.4)
—

Visit the website for up-to-date information about additional add-ons and features as they 

become available. The website also has the latest revision of this user’s manual.
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1.3  Development and Evaluation Tools

1.3.1  Tool Kit

A Tool Kit contains the hardware essentials you will need to use your own BL4S100 single-

board computer. These items are supplied in the Tool Kit.

� Getting Started instructions.

� Dynamic C CD-ROM, with complete product documentation on disk.

� USB programming cable, used to connect your PC USB port to the BL4S100.

� Universal AC adapter, 12 V DC, 1 A (includes Canada/Japan/U.S., Australia/N.Z., 

U.K., and European style plugs).

� Demonstration Board with pushbutton switches and LEDs. The Demonstration Board 

can be hooked up to the BL4S100 to demonstrate the I/O and capabilities of the 

BL4S100.

� DB9 to bare leads serial cable.

� CAT 5/6 Ethernet crossover cable.

� Screwdriver.

� Rabbit 4000 Processor Easy Reference poster.

� Registration card.

Figure 1.  BL4S100 Tool Kit

•

•

•

•

•

•

•

•

•

•

set up.exe
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1.3.2  Software

The BL4S100 is programmed using version 10.44 or later of Rabbit’s Dynamic C. A com-

patible version is included on the Tool Kit CD-ROM. This version of Dynamic C includes the 

popular µC/OS-II real-time operating system, point-to-point protocol (PPP), FAT file 

system, RabbitWeb, and other select libraries.

Rabbit also offers for purchase the Rabbit Embedded Security Pack featuring the Secure 

Sockets Layer (SSL) and a specific Advanced Encryption Standard (AES) library. In addi-

tion to the Web-based technical support included at no extra charge, a one-year telephone-

based technical support subscription is also available for purchase. Visit our website for 

further information and complete documentation, or contact your Rabbit sales 

representative or authorized distributor.

1.3.3  Optional Add-Ons

Rabbit has a plastic enclosure and a Mesh Network Add-On Kit available for the 

BL4S100.

Visit our website at www.digi.com or contact your Rabbit sales representative or 

authorized distributor for further information.

� Mesh Network Add-On Kit (Part No. 101-1272)

 Digi® XBee USB (used as ZigBee coordinator)

 XBee Series 2 RF module

 RF Interface module

The XBee Series 2 RF module is installed on the RF Interface module, which can be 

connected via an RS-232 serial connection to a Windows PC for setup. The Mesh Net-

work Add-On Kit enables you to explore the wireless capabilities of BL4S100 models 

that offer a ZigBee network interface.

� Plastic enclosure (Part No. 181-0041)

Further details on the plastic enclosure are provided in 

Appendix E.
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1.4  CE Compliance

Equipment is generally divided into two classes.

These limits apply over the range of 30–230 MHz. The limits are 7 dB higher for frequen-

cies above 230 MHz. Although the test range goes to 1 GHz, the emissions from Rabbit-

based systems at frequencies above 300 MHz are generally well below background noise 

levels.

The BL4S100 single-board computer has been tested and was found to 

be in conformity with the following applicable immunity and emission 

standards. The BL4S110, BL4S150, and BL4S160 single-board 

computers are also CE qualified as they are sub-versions of the BL4S100 

single-board computer. Boards that are CE-compliant have the CE mark.

Immunity

The BL4S100 series of single-board computers meets the following EN55024/1998 

immunity standards.

� EN61000-4-3 (Radiated Immunity)

� EN61000-4-4 (EFT)

� EN61000-4-6 (Conducted Immunity)

Additional shielding or filtering may be required for a heavy industrial environment.

Emissions

The BL4S100 series of single-board computers meets the following emission standards.

� EN55022:1998 Class B

� FCC Part 15 Class B 

Your results may vary, depending on your application, so additional shielding or filtering 

may be needed to maintain the Class B emission qualification.

CLASS A CLASS B

Digital equipment meant for light industrial use Digital equipment meant for home use

Less restrictive emissions requirement:

less than 40 dB µV/m at 10 m

(40 dB relative to 1  µV/m) or 300 µV/m

More restrictive emissions requirement:

30 dB µV/m at 10 m or 100 µV/m
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1.4.1  Design Guidelines

Note the following requirements for incorporating the BL4S100 series of single-board 

computers into your application to comply with CE requirements.

General

� The power supply provided with the Tool Kit is for development purposes only. It is the 

customer’s responsibility to provide a CE-compliant power supply for the end-product 

application.

� When connecting the BL4S100 single-board computer to outdoor cables, the customer 

is responsible for providing CE-approved surge/lighting protection.

� Rabbit recommends placing digital I/O or analog cables that are 3 m or longer in a 

metal conduit to assist in maintaining CE compliance and to conform to good cable 

design practices.

� When installing or servicing the BL4S100, it is the responsibility of the end-user to use 

proper ESD precautions to prevent ESD damage to the BL4S100.

Safety

� All inputs and outputs to and from the BL4S100 series of single-board computers must 

not be connected to voltages exceeding SELV levels (42.4 V AC peak, or 60 V DC).

� The lithium backup battery circuit on the BL4S100 single-board computer has been 

designed to protect the battery from hazardous conditions such as reverse charging and 

excessive current flows. Do not disable the safety features of the design.

1.4.2  Interfacing the BL4S100 to Other Devices

Since the BL4S100 series of single-board computers is designed to be connected to other 

devices, good EMC practices should be followed to ensure compliance. CE compliance is 

ultimately the responsibility of the integrator. Additional information, tips, and technical 

assistance are available from your authorized Rabbit distributor, and are also available on 

our website.
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2.  GETTING STARTED

Chapter 2 explains how to connect the programming cable and power sup-

ply to the BL4S100.
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2.1  BL4S100 Connections

Step 1 — Connect Programming Cable

The programming cable connects the BL4S100 to the PC running Dynamic C to download 

programs and to monitor the BL4S100 module during debugging.

Connect the 10-pin PROG connector of the programming cable to header J8 on the 

BL4S100. Ensure that the colored edge lines up with pin 1 as shown. (Do not use the 

DIAG connector, which is used for monitoring only.) Connect the other end of the pro-

gramming cable to an available USB port on your PC or workstation.

Figure 2.  Programming Cable Connections

Your PC should recognize the new USB hardware, and the LEDs in the shrink-wrapped 

area of the USB programming cable will flash — if you get an error message, you will 

have to install USB drivers. Drivers for Windows XP are available in the Dynamic C 

Drivers\Rabbit USB Programming Cable\WinXP_2K folder — double-click 

DPInst.exe to install the USB drivers. Drivers for other operating systems are available 

online at www.ftdichip.com/Drivers/VCP.htm.
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Step 2 — Connect Power Supply

Once all the other connections have been made, you can connect power to the BL4S100.

First, prepare the AC adapter for the country where it will be used by selecting the plug. 

The Tool Kit presently includes Canada/Japan/U.S., Australia/N.Z., U.K., and European 

style plugs. Snap in the top of the plug assembly into the slot at the top of the AC adapter 

as shown in Figure 3, then press down on the spring-loaded clip below the plug assembly 

to allow the plug assembly to click into place. Release the clip to secure the plug assembly 

in the AC adapter.

Connect the power supply to header J17 on the BL4S100 as shown in Figure 3. Be sure to 

match the latch mechanism with the top of the connector to header J17 on the BL4S100 as 

shown. The Micro-Fit® connector will only fit one way.

Figure 3.  Power Supply Connections

Plug in the AC adapter. The red LED next to the power connector at J17 should light up. 

The BL4S100 is now ready to be used.

CAUTION: Unplug the power supply while you make or otherwise work with the connections 

to the headers. This will protect your BL4S100 from inadvertent shorts or power spikes.

2.1.1  Hardware Reset

A hardware reset is done by unplugging the power supply, then plugging it back in, or by 

pressing the RESET button located next to the Ethernet jack.
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2.2  Installing Dynamic C

If you have not yet installed Dynamic C version 10.44 (or a later version), do so now by 

inserting the Dynamic C CD from the BL4S100 Tool Kit in your PC’s CD-ROM drive. If 

autorun is enabled, the CD installation will begin automatically.

If autorun is disabled or the installation does not start, use the Windows Start | Run menu 

or Windows Disk Explorer to launch setup.exe from the root folder of the CD-ROM.

The installation program will guide you through the installation process. Most steps of the 

process are self-explanatory.

NOTE: If you have an earlier version of Dynamic C already installed, the default instal-

lation of the later version will be in a different folder, and a separate icon will appear on 

your desktop.

The online documentation is installed along with Dynamic C, and an icon for the docu-

mentation menu is placed on the workstation’s desktop. Double-click this icon to reach the 

menu. If the icon is missing, create a new desktop icon that points to default.htm in the 

docs folder, found in the Dynamic C installation folder. The latest versions of all docu-

ments are always available for free, unregistered download from our websites as well.

The Dynamic C User’s Manual provides detailed instructions for the installation of 

Dynamic C and any future upgrades.

Once your installation is complete, you will have up to three icons on your PC desktop. 

One icon is for Dynamic C, one opens the documentation menu, and the third is for the 

Rabbit Field Utility, a tool used to download precompiled software to a target system.

If you have purchased any of the optional Dynamic C modules, install them after installing 

Dynamic C. The modules may be installed in any order. You must install the modules in 

the same directory where Dynamic C was installed.
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2.3  Starting Dynamic C

Once the BL4S100 is connected to your PC and to a power source, start Dynamic C by 

double-clicking on the Dynamic C icon on your desktop or in your Start menu. Select 

Store Program in Flash on the “Compiler” tab in the Dynamic C Options > Project 

Options menu. Then click on the “Communications” tab and verify that Use USB to 

Serial Converter is selected to support the USB programming cable. Click OK.

You may have to select the COM port assigned to the USB programming cable on your 

PC. In Dynamic C, select Options > Project Options, then select this COM port on the 

“Communications” tab, then click OK. You may type the COM port number followed by 

Enter on your computer keyboard if the COM port number is outside the range on the 

dropdown menu.

2.4  Run a Sample Program

You are now ready to test your set-up by running a sample program.

Use the File menu to open the sample program PONG.C, which is in the Dynamic C 

SAMPLES folder. Press function key F9 to compile and run the program. The STDIO 

window will open on your PC and will display a small square bouncing around in a box.

This program shows that the CPU is working. The sample program described in 

Section 5.2.3, “Run the PINGME.C Demo,” tests the TCP/IP portion of the board.

2.4.1  Troubleshooting

If you receive the message No Rabbit Processor Detected, the programming cable 

may be connected to the wrong COM port, a connection may be faulty, or the target sys-

tem may not be powered up. First, check to see that the red power LED next to header J5 

is lit. If the LED is lit, check both ends of the programming cable to ensure that it is firmly 

plugged into the PC and the programming header on the BL4S100 with the marked (col-

ored) edge of the programming cable towards pin 1 of the programming header.

If Dynamic C appears to compile the BIOS successfully, but you then receive a communi-

cation error message when you compile and load a sample program, it is possible that your 

PC cannot handle the higher program-loading baud rate. Try changing the maximum 

download rate to a slower baud rate as follows.

� Locate the Serial Options dialog on the “Communications” tab in the Dynamic C 

Options > Project Options menu. Select a slower Max download baud rate. Click OK 

to save.

If a program compiles and loads, but then loses target communication before you can 

begin debugging, it is possible that your PC cannot handle the default debugging baud 

rate. Try lowering the debugging baud rate as follows.

� Locate the Serial Options dialog on the “Communications” tab in the Dynamic C 

Options > Project Options menu. Choose a lower debug baud rate. Click OK to save.

Press <Ctrl-Y> to force Dynamic C to recompile the BIOS. You should receive a Bios 

compiled successfully message once this step is completed successfully.
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2.4.2  Run a ZigBee Sample Program (BL4S100/BL4S150 only)

This section explains how to run a sample program in which the BL4S100/BL4S150 is used 

in its default setup as a router and the Digi XBee USB is used as the ZigBee coordinator.

1. Connect the Digi XBee USB acting as a ZigBee coordinator to an available USB port 

on your PC or workstation. Your PC should recognize the new USB hardware.

2. Find the file AT_INTERACTIVE.C, which is in the Dynamic C SAMPLES\XBee folder. 

To run the program, open it with the File menu, then compile and run it by pressing F9. 

The Dynamic C STDIO window will open to display a list of AT commands. Type 

MENU to redisplay the menu of commands.

Appendix F provides additional configuration information if you experience conflicts 

while doing development simultaneously with more than one ZigBee coordinator, or if you 

wish to upload new firmware.
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2.5  Where Do I Go From Here?

NOTE: If you purchased your BL4S100 through a distributor or Rabbit partner, contact 

the distributor or partner first for technical support.

If there are any problems at this point:

� Use the Dynamic C Help menu to get further assistance with Dynamic C.

� Check the Rabbit Technical Bulletin Board and forums at www.digi.com/support/ and 

at www.digi.com/forum/support/rabbit.

� Click tech.support@digi.com to send an email to Technical Support.

If the sample program ran fine, you are now ready to go on to explore other BL4S100 

features and develop your own applications.

When you start to develop an application involving the analog inputs, run USERBLOCK_

READ_WRITE.C in the SAMPLES\UserBlock folder to save the factory calibration con-

stants before you run any other sample programs in case you inadvertently write over 

them while running another sample program.

Chapter 3, “Subsystems,” provides a description of the BL4S100’s features, Chapter 4, 

“Software,” describes the Dynamic C software libraries and introduces some sample 

programs, and explains the TCP/IP features.
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3.  SUBSYSTEMS

Chapter 3 describes the principal subsystems for the BL4S100.

� Digital I/O

� Serial Communication

� A/D Converter Inputs

� Memory

Figure 4 shows these Rabbit-based subsystems designed into the BL4S100.

Figure 4.  BL4S100 Subsystems
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3.1  BL4S100 Pinouts

The BL4S100 pinouts are shown in Figure 5.

Figure 5.  BL4S100 Pinouts

3.1.1  Connectors

Standard BL4S100 models are equipped with an RJ-45 Ethernet jack, four 1 × 9 screw-

terminal headers and one 1 × 6 screw-terminal header for the I/O and RS-232 signals. The 

polarized 2 × 2 Micro-Fit connector at J17 is for the power supply connection.
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3.2  Digital I/O

3.2.1  Digital Inputs

The BL4S100 has 12 digital inputs, IN0–IN11, each of which is protected over a range of 

–36 V to +36 V. The inputs are factory-configured to be pulled up to +5 V, but they can 

also be pulled up to +K or pulled down to 0 V by changing a jumper as shown in Figure 6.

Figure 6.  BL4S100 Digital Inputs IN0–IN11 [Pulled Up to +5 V—Factory Default]

Table 2 summarizes the jumper settings.

CAUTION: Do not simultaneously jumper more than one setting when configuring 

the pull-up or pull-down options.

Table 2.  BL4S100 Digital Input Pull-Up/Pull-Down Jumper Settings

Pins Jumpered Pulled Up/Pulled Down

1–2 Inputs pulled up to +K

2–4 or 4–6 Inputs pulled down to GND

5–6 Inputs pulled up to +5 V
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Individual digital input channels may be also used for counters, synching, interrupts, input 

capture, or as quadrature decoder inputs. The use of these channels for interrupts, input 

capture, and as quadrature decoders is described below.

Blocks of digital input pins are associated with counters/timers on the Rabbit RIO chip. 

Table 3 provides complete details for these associations.

Appendix D provides further details on the blocks and pins associated with the Rabbit 

RIO chip to facilitate configuring each block consistently and to identify misconfigured 

pins when a software function call returns a Mode Conflict error code.

The actual switching threshold is approximately 

1.40 V. Anything below this value is a logic 0, 

and anything above 1.90 V is a logic 1. The 

digital inputs are each fully protected over a 

range of -36 V to +36 V, and can handle short 

spikes of ±40 V.

NOTE: If the inputs are pulled up to +K, the 

voltage range over which the digital inputs are 

protected changes to +K – 36 V to +36 V.

Figure 7.  BL4S100 Digital Input 

Protected Range

CAUTION: Do not allow the voltage on a digital input pin to exceed ±36 V to 

avoid damaging the input.

Table 3.  Counter/Timer Associations for BL4S100 Digital Input Pins

Configurable I/O 

Pin(s)

Counter/Timer 

Blocks

Block Shared 

With

IN0–IN2 0 XBee RF module

IN3–IN5 1 —

IN6–IN7 2 OUT0–OUT1

IN8–IN9 3 OUT2–OUT3

IN10 6 —

IN11 7 —
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Keep the following guidelines in mind when selecting special uses for the digital input pins.

� Interrupts, event counters, and input capture are available on any digital input pin.

� Each Quadrature Decoder channel requires at least two digital input pins associated 

with the same counter/timer block; three digital input pins associated with the same 

counter/timer block are needed if you need indexing. Quadrature Decoder channels are 

configured using the setDecoder() function call.

Sample programs in the DIO subdirectory in SAMPLES\BL4S1xx show how to set up and 

use digital inputs for interrupts, pulse capture, and quadrature decoders.

3.2.1.1  Interrupt, Counter, and Event Capture Setup

External interrupts on the BL4S100 digital input pins are configured using the setEx-

tInterrupt() function call. The interrupt can be set up to occur on a rising edge, a fall-

ing edge, or either edge.

The counter readings can be obtained via the getBegin() or getEnd() function calls.

An input channel may be set up to count 

events, with the count incrementing or 

decrementing, using the rising edge, fall-

ing edge, or either edge as triggers to start/

end the count. This feature is configured 

using the setCounter() function call.

A more extensive use of the timing abilities 

of the BL4S100 inputs can be realized 

through the event capture function call, 

setCapture(). Here the count of a par-

ticular clock cycle is noted at the start of the 

event and at the end of the event so that the 

time between them can be determined. This 

can be set up on one or two input channels. 

The event counter can be reset with the 

resetCounter() function call.
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3.2.2  Digital Outputs

The BL4S100 has eight digital outputs, OUT0–OUT7, which can each sink up to 200 mA. 
Figure 8 shows a wiring diagram for using the sinking digital outputs.

Figure 8.  BL4S100 Digital Outputs

OUT0–OUT3 are powered by +K1, and OUT4–OUT7 are powered by +K2. +K1 and 

+K2 can each be up to 36 V. They don't have to be the same. All the sinking current, which 

could be up to 1.6 A, is returned through the GND pin. Be sure to use a suitably sized 

ground wire and keep the distance to the power supply as short as possible.

All the digital outputs sink actively. They can be used as low-side drivers, or as an H-bridge 
driver. When the BL4S100 is first powered up or reset, all the outputs are disabled, that is 
at a high-impedance state.

Individual digital output channels may be used for PWM/PPM outputs.The use of these 

channels for PWM/PPM is described in Section 3.2.2.1.

For the H bridge, which is shown in Figure 9, 

Ka and Kb should be the same. This is most 

easily accomplished by using outputs from the 

same bank on one connector.

Figure 9.  H Bridge
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Blocks of digital output pins are associated with counters/timers on the Rabbit RIO chip. 

Table 4 provides complete details for these associations.

Appendix D provides further details on the blocks and pins associated with the Rabbit 

RIO chip to facilitate configuring each block consistently and to identify misconfigured 

pins when a software function call returns a Mode Conflict error code.

Keep the following guidelines in mind when selecting special uses for the digital output 

pins.

� When using digital output pins for PWM/PPM outputs, the output pins can only share 

the same RIO block if they are using the same period or frequency.

The PWM.C and the PPM.C sample programs in the DIO subdirectory in SAMPLES\

BL4S1xx show how to set up and use the PWM/PPM outputs.

Table 4.  Counter/Timer Associations for BL4S100 Digital Output Pins

Configurable I/O 

Pin(s)

Counter/Timer 

Blocks
Block Shared With

OUT0–OUT1 2 IN6–IN7

OUT2–OUT3 3 IN8–IN9

OUT4–OUT5 4
RabbitNet

(reserved for future use)

OUT6–OUT7 5 A/D converter
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